V-STUDIO 700 A CLOSER LOOK
By Scott R. Garrigus

Discovering the Ultimate SONAR Experience
Copyright ©2010 by Scott R. Garrigus. All Rights Reserved. Redistributed with Permission.

Although this eBook is provided to you free of charge, it is still a copyrighted publication. As such, there are some rules that apply to how you may use this publication. The rules are as follows...

* You may do the following with this eBook:
  - Redistribute it via email, websites, file sharing, and electronic media provided that you distribute the entire PDF file exactly as-is without any changes and you do so free-of-charge.
  - Print it out for your own personal use.
  - Make backup copies for your own personal use.

* You may NOT do the following with this eBook:
  - Redistribute it for sale.
  - Copy and publish any individual parts of the information contained herein.
  - Make changes to the PDF and republish it.

If you have any questions about these terms, or would like information about licensing, please contact the author at: www.garrigus.com.

All copyrights and trademarks used as examples or references in this publication are retained by their individual owners.

This publication is provided for informational purposes only. Any damage resulting from the use of the information herein is the sole responsibility of the reader. The author and publisher do not accept any responsibility for the actions taken by readers based upon the contents in this publication.

Scott R. Garrigus
Garrigus.com
P.O. Box 458
Stafford Springs, CT 06076 USA
www.garrigus.com
About the Author
Currently working as a freelance author and musician, Scott R. Garrigus (www.garrigus.com) has been helping people unlock the secrets of Cakewalk’s SONAR sequencing application and other music technology products for more than ten years. He has been involved with music and music technology for more than 20 years and has taught people of all ages about the wonderful process of making music. He first got involved making music with computers when Atari came out with the Atari 520ST, one of the first computers with built-in MIDI capabilities. From then on, Scott was hooked. He pursued a career in music by attending the UMass Lowell College of Music and earning himself a B.A. in Music Performance with an emphasis in Sound Recording Technology.

His first published article appeared in a 1995 issue of Electronic Musician magazine. His first book (called Cakewalk Power!) was published in 1999. Since then, Scott has written numerous books including the SONAR Power! book series. In addition to books and magazine articles, Scott publishes his own music technology newsletter called DigiFreq (www.digifreq.com), which boasts over 20,000 readers.

About Cakewalk
Cakewalk (www.cakewalk.com) is the world’s leading developer of powerful and easy to use products for music creation and recording. These products include award-winning digital audio workstations and sequencers, fully-integrated music software and hardware solutions, and innovative virtual instruments. Millions of musicians worldwide—including Grammy® and Emmy®-winning producers, composers, sound designers, and engineers—use Cakewalk products daily to produce audio for the professional music, film, broadcast, and video game industries.

Together with Roland, Cakewalk has created the V-Studio 700 (www.V-studio.info), which provides the ultimate solution for creative music production through a complete offering of finely tuned and tightly-integrated hardware and software. Taken as a whole, the V-Studio 700 offers the “tactile feel” of working in a traditional studio, but in a way that takes advantage of everything modern technology has to offer. The system represents the best that software and hardware have to offer with amazing control, integration, and sound quality.
# Table of Contents

## Introduction
- How this eBook is Organized ................................................................. 1
- How to Use this eBook............................................................ 1
- Notes and Tips............................................................................. 2
- Interactive Website Links.......................................................... 2
- Interactive Picture Enlargements............................................... 3

## 1. Getting to Know the V-Studio 700 .................................................................................. 4
- A Quick Tour of the V-Studio 700 ..................................................... 4
- The VS-700C Control Surface ....................................................... 4
- The VS-700R Audio/MIDI Interface .............................................. 5
- The Roland Fantom VS Hardware Synth ......................................... 6
- SONAR Producer Edition DAW Software........................................ 6
- A Typical V-Studio 700 Studio Setup ............................................. 7
  - Setting up the Hardware .......................................................... 7
  - Setting up the Software .......................................................... 8
- Registering and Updating the V-Studio 700 .................................... 8

## 2. Recording with the V-Studio 700 ............................................................................. 10
- Setting Up for Sound with the VS-700R .......................................... 10
  - Controlling the VS-700R Audio Interface .................................... 10
    - The V-Studio 700 Property Page .............................................. 10
    - The Direct Monitor Mixer ...................................................... 11
- Recording in the Studio – Home and Pro ...................................... 12
  - Recording in a Home Studio ....................................................... 12
  - Recording in a Pro Studio .......................................................... 14
  - Monitoring in a Pro Studio .......................................................... 14
  - What About Talkback? ............................................................ 14

## 3. Composing with the V-Studio 700 ............................................................................. 17
- Working with MIDI Tracks ............................................................. 17
  - MIDI Track Setup ................................................................. 17
  - MIDI Track Recording ............................................................. 18
- Working with the Roland Fantom VS Synthesizer ......................... 18
  - My Fantom VS Song Project Template ..................................... 19
    - The Fantom VS Template Tracks ............................................ 19
    - Controlling the Tracks from the VS-700C ................................ 19
    - Tweaking the Fantom VS Patch and Mixing Parameters ......... 20
- Composing with Synth Parameter Automation ............................. 21
  - The Synth Rack View ............................................................. 21

## 4. Editing with the V-Studio 700 .................................................................................. 23
- Modes of Operation ....................................................................... 23
  - Transport Mode ................................................................. 23
  - Scroll Mode .......................................................................... 23
  - Zoom Mode .......................................................................... 24
  - Select Mode .......................................................................... 25
  - Edit Mode ............................................................................. 25
    - Editing Selected Time ......................................................... 25
    - Editing Selected Clips ....................................................... 26
- Mode Combinations for Workflow ................................................ 27
  - Finding Data to Edit ............................................................. 27
    - Controlling the Now Time .................................................... 27
    - Controlling the Free Edit Cursor ........................................... 27
      - Independent Navigation .................................................... 27
  - Zoom Mode or Not? ............................................................... 28
  - Data Selection Shortcuts ....................................................... 28
  - Optional Editing Workflow .................................................... 28
Introduction

From its humble beginnings as a DOS MIDI sequencer through its transformation of becoming an audio sequencer (formally known as Cakewalk Pro Audio), SONAR has grown into one of the most powerful digital audio workstation applications in the world. Over the years, many features have been added and changed (most of which in respect to user's wishes), creating a working environment that musicians from all walks of life enjoy. But although the SONAR software is at the heart of many of today's modern music studios, it does not create a complete production environment in and of itself – hardware still plays a very significant role. By joining with Roland, Cakewalk expanded its role into the hardware market by integrating support for Roland products (such as the Edirol PCR keyboards) within SONAR. They then expanded further by bundling SONAR with hardware to release products such as the SONAR Power Studio, which included SONAR and an Edirol audio/MIDI interface. Only with the release of the V-Studio 700, however, has Cakewalk provided an all-inclusive product to create a fully-integrated music production package.

Over the years, SONAR has been the central part of my studio and I've used it to create many different types of projects. In conjunction with the software, I've used a variety of outboard gear (control surfaces, audio/MIDI interfaces, keyboards, effects units, etc.) to try and create a studio environment conducive to my workflow. For the most part, I was happy with what I had and always produced professional results without missing a deadline. But even though SONAR can be configured to work with a variety of gear, I've never found the perfect combination that allowed me to do everything "in-the-box" and not have to worry about external hardware configurations, routings, and settings. Then along came the V-Studio 700 and I knew that I had to check it out. Could it be that there was finally an all-in-one solution for my favorite DAW that would allow me to upgrade my studio to the level of integration I was looking for?

How this eBook is Organized
In this eBook, I will take you on a tour of the V-Studio 700 system and talk about what it is, what it can do, and what my experiences have been while using it in my studio. I'll also provide some useful tips and techniques for those of you that already own the system.

Chapter 1, "Getting to Know the V-Studio 700," provides an introduction to the system including a discussion about the system components, registering the system, setting up the system in a studio environment, and updating with the latest firmware and software.

Chapter 2, "Recording with the V-Studio 700," talks about how to use the system when recording tracks in SONAR. You'll find detailed information about the VS-700R MIDI and audio interface, including the level of quality and integration that it provides.

Chapter 3, "Composing with the V-Studio 700," describes some of the ways that the system can be helpful with music composition. It also covers working with software synthesizers via the V-Studio 700, as well as the usefulness of the integrated Roland Fantom hardware synth.

Chapter 4, "Editing with the V-Studio 700," shows you how the system can be used for editing recorded data in SONAR. Information on how to customize the VS-700C control surface is also provided here.
Chapter 5, "Mixing with the V-Studio 700," takes a look at how the system can enhance your SONAR mixing sessions. From the motorized faders (and other channel controls) to the effect plug-in access, this chapter covers the extensive capabilities of the VS-700C control surface.

Chapter 6, "Final Thoughts and Tips for the V-Studio 700," concludes this eBook with some closing remarks, along with some additional advice and musings on working with the system.

Appendix A, "V-Studio 700 Resources," lists some additional sources of information about the V-Studio 700 system, including official web site links, forum links, support links, and video links.

Appendix B, "Additional Information," includes a few final pieces of information that you may find helpful when using the V-Studio 700 system in your studio.

How to Use this eBook
This eBook has been specifically formatted for easy printing. The white background, 8.5 x 11 page size, and mirrored margins allow you to print either one-sided or two-sided pages on any standard printer. To do so, simply choose File > Print in the Adobe Reader menu. In addition, when accessing the eBook in its electronic form, you'll find that there are a number of special features provided to enhance your reading experience.

Notes and Tips
Included in this eBook are small sections that will impart specific types of information in regards to the current topic you are reading. These sections come in the form of notes and tips. Notes are designated by a sticky note logo – they provide personal insights, stories, and additional material that you might find interesting. Tips are designated by a lightbulb logo – they provide extra information related to the topic being discussed, including techniques that you should know.

Interactive Website Links
As you read this eBook, you'll come across some special text that is bold, underlined, and displayed with the color blue. These special pieces of text are links that you can click on with your mouse. For example, here is a link to my website: www.garrigus.com. When you click a link, the Adobe Reader will launch your default web browser, which will then bring you to the corresponding website. Of course, you need to have a live Internet connection for this feature to work.

Adobe Reader Warning Dialog
In order to keep people safe from malicious websites, the Adobe Reader automatically displays a warning every time you click on a link in a PDF file. To stop this warning from being displayed, put a checkmark next to the option called: Remember My Action For This Site. You can rest assured that all of the links in this eBook are safe.

Table of Contents Links
In addition to website links, this eBook provides an interactive table of contents. Just click on any topic listed in the table of contents and the Adobe Reader will automatically take you to that section of the eBook.

www.garrigus.com / www.cakewalk.com
**Interactive Picture Enlargements**

Along with clickable links, some of the pictures in this eBook can also be clicked to access enlarged versions for easier viewing. Pictures that can be clicked are shown with a bold, blue outline. When you click on a picture, Adobe Reader will launch your default web browser, which will then display an enlarged version of the picture. To hide the picture, simply close your web browser. Of course, as with website links, you need a live Internet connection for this feature to work.

---

**Cakewalk Sponsorship**

As it is stated on the cover of this eBook, the development of this publication was sponsored by Cakewalk. That is the reason this eBook is provided to you free-of-charge. However, please keep in mind that this sponsorship has in no way affected my opinion of the V-Studio 700 system.

As with all the publications that I write, I provide candid and forthright observations throughout these pages. Both Cakewalk and Roland support my stance on providing factual information and truthful remarks even when those remarks might shine a light on any shortcomings of the system.

However, I will tell you up-front that I find the V-Studio 700 to be an excellent product that provides an extensive amount of power. Are there some things that I would like to see improved? Yes, and I will tell you about them, but for the most part I can definitely say that the system has taken my use of SONAR to the next level.

---

**Are You Reading DigiFreq?**

I have created a site called DigiFreq that provides free news, reviews, tips and techniques for all levels of music technology users. There is a discussion area (forum) where you can post your questions and get helpful answers. You can also get a free subscription to the DigiFreq music technology newsletter, which includes articles, tips, and all kinds of music technology information, including application techniques for a wide variety of music hardware and software. Plus, as a subscriber you are eligible to win free music products, and you also have access to all of the newsletter back issues. If you are interested in pro audio and music technology (and you must be since you are reading this eBook), then DigiFreq is the place to be. Stop by to sign up for the free newsletter and meet all of the other SONAR users out there! Go to: [http://www.digifreq.com/digifreq/](http://www.digifreq.com/digifreq/)
1. Getting to Know the V-Studio 700

The V-Studio 700 is a complete system that combines the SONAR Producer Edition software, the company's flagship software synths (Dimension Pro and Rapture), a state-of-the-art control surface (VS-700C), a professional audio/MIDI interface (VS-700R), and a Roland Fantom hardware synth (built into the VS-700R) to create a fully-integrated music production package.

A Quick Tour of the V-Studio 700

As you can imagine, I was very excited when the system arrived on my doorstep. Packed inside a single 57-pound box, each component was also individually boxed along with the included cables, documentation, and software DVDs. Included in my package was the following:

- the VS-700C Control Surface
- the VS-700R audio/MIDI Interface
- two power cords – one for the VS-700C and one for the VS-700R
- a USB cable for connecting the VS-700R to a PC
- a special cable for connecting the VS-700C to the VS-700R
- VS-700R rack mount brackets
- SONAR 8 Producer installation DVD
- SONAR 8 additional content DVD
- Beatscape installation DVD
- Dimension Pro 1.2 installation DVD
- CD containing V-Studio 700 drivers, SONAR 8.0.2 patch, Fantom VS Editor, VS-700 Control plug-in, Rapture, and Rapture Expansion Packs
- V-Studio 700 Getting Started Guide (62 pages)
- V-Studio 700 Owner's Manual (186 pages)
- SONAR 8 User's Guide (203 pages)
- V-Studio 700 Shortcuts and Quick Keys Guide
- V-Studio Errata information sheet
- Repair service information sheet
- Read This First! information sheet

VIDEO: Cakewalk V-Studio 700 Unboxing

http://digifreq.com/?DFVI4

Watch as I unbox my V-Studio 700 system. See how the V-Studio 700 looks when it first comes out of the box. Check out all the accessories that are included. And see a quick tour of the VS-700R audio/MIDI interface and the VS-700C control surface. Also, keep an eye out for more videos at: http://www.digifreq.com/digifreq/videos.asp

The VS-700C Control Surface

With dimensions of 28-3/4 (W) x 17 (D) x 5 (H) inches and a weight of 22 lbs 8 oz, the VS-700C (see Figure 1) is a very solid piece of equipment that provides control not only for the SONAR software, but also for the VS-700R hardware (I'll explain that in the next section). The control surface is divided into nine major areas.
The Transport area provides a jog/shuttle wheel, transport buttons, project command buttons, and record/edit command buttons. The Surround area includes a surround sound joystick and other surround-related controls. The T-Bar area has a T-Bar as well as buttons that determine the T-Bar functionality. The Time Display area shows the current Now time in a SONAR project and can be configured to show Bars/Beats or SMPTE time code. The LCD Display area shows information relating to the Channel Strip Control area as well as the Channel Strips area.

In the Channel Strips area, the VS-700C provides nine motorized faders (eight channel faders and one master fader). Each channel strip has a 5-segmented LED level meter, a Select button, Arm button, Solo button, Mute button, and a rotary encoder. The faders and encoders can be configured to control a number of different parameters. When the Select button for a channel strip is pressed, you can perform more detailed control of that channel strip via the Channel Strip Control area. This area allows you to control track EQ, sends, and ACT (including plug-in FX and soft synth parameters) for the selected channel – all done directly from the VS-700C control surface. The Access Panel area gives you quick access to many of SONAR’s views and editing functions – it can also be customized to launch other SONAR functions of your choosing. Finally, the Audio Output area gives you control over the VS-700R Main and Sub monitor levels, as well as the headphone connections on the VS-700C.

The VS-700R Audio/MIDI Interface
The 2U rackmount-sized VS-700R (see Figure 2) provides all of the hardware audio/MIDI processing for the V-Studio 700 system. On the front are the LED indicators for various functions, as well as an 8-segmented LED meter for each audio input.

The back of the interface provides all of the cable connections needed for operation of the system. These connections include: single MIDI in/out ports, 8 TRS/XLR (unbalanced/balanced) microphone preamps/audio inputs, 10 TRS (unbalanced/balanced) audio outputs, Main and Sub monitor XLR and TRS outputs, Word Clock in/out, digital SPDIF coaxial in/out, digital AES/EBU XLR in/out, and digital ADAT optical in/out. If you need more connections, the system can accommodate a second VS-700R unit. You can find instructions on how to set this up on page 166 of the VS-700 Owner's Manual.
A proprietary cable connects the VS-700R to the VS-700C, thus allowing you to control the interface from the control surface as well as via software. Audio clock source, phantom power, mic preamp parameters, digital compressor parameters, and direct monitor mixer parameters can all be controlled via software. The only exception is the sample rate, which must be set manually via a knob on the front of the VS-700R. Unfortunately, changing the sample rate also requires a recycling of the system power. In addition, the SONAR software doesn't allow you to convert the sample rate of a project containing audio data.

**Set the Sample Rate Before Opening SONAR**

I'm sure there's a technical reason for having a manual sample rate setting, but it can still be annoying nonetheless. To save yourself some grief, you can keep track of a project's sample rate by adding it to the project filename. That way you can set the Sample Rate knob before even powering up the VS-700R or starting SONAR.

### The Roland Fantom VS Hardware Synth

In addition to MIDI/audio I/O, tucked inside the VS-700R is a full-blown Roland Fantom VS hardware synth. The Fantom VS provides over 1,400 patches ranging from acoustic to electronic instruments as well as drum kits (called Rhythm Sets). The synth also provides 16-part multi-timbral operation and GM (General MIDI) compatibility. The only limitation is the 128-voice polyphony, which can get used up quickly depending on the number of instruments and which patches you use.

What makes the Fantom VS unique is its ability to be accessed as a soft synth inside of SONAR, but still operate as a hardware synth, thus eliminating any power drain on the PC CPU. You can insert the Fantom VS into a project just like any other soft synth and access its parameters via the Fantom VS Editor (see Figure 3). The Editor allows you to control every aspect of the synth, including editing any of the provided patches to create your own new patches. A variety of synthesis methods can be achieved and the Fantom VS even provides a wide-array of built-in effects.

The Fantom VS can also be expanded by adding a Roland SuperNATURAL ARX expansion board to the VS-700R. The ARX expansion boards each provide an entirely new set of sounds that automatically work in conjunction with the built-in Fantom VS sounds. The downside is that you can only install one ARX board and the procedure (while not difficult – see page 155 in the VS-700 Owner's Manual) doesn't lend itself to the quick and easy swapping of boards.

### SONAR Producer Edition DAW Software

Finally, tying the entire V-Studio 700 system together is the SONAR Producer Edition software (currently at version 8.5.3). Of course, you can use the VS-700C, the VS-700R, and even the Fantom VS with other software, but these components are designed to work seamlessly with SONAR.
The VS-700R acts like any other audio/MIDI interface inside of SONAR with the exception that you can control most of its settings via the software (and those settings are saved on a project-by-project basis). The Fantom VS can be accessed and used like a soft synth (via the Insert > Soft Synth menu) although it actually runs as hardware. And the VS-700C gives you access to most SONAR functions so that you don't have to rely nearly as much on your computer keyboard or mouse.

A Typical V-Studio 700 Studio Setup

Setting up the V-Studio 700 system is quite easy and I had mine up-and-running in no time at all. The most time consuming aspect is installing all the software, but even that is straightforward.

Setting up the Hardware

For the most part, I followed the VS-700 Getting Started guide to ensure that my system was set up properly. I recommend you do the same, but here's an overview of what I did:

1. I wrote down the serial numbers for the VS-700C and VS-700R (needed for registration, which I'll discuss later). You can find the VS-700C serial number on the back (not bottom) of the unit. You can find the VS-700R serial number on the right side of the unit.
2. I positioned the VS-700C on my studio desk with the center of control surface corresponding to the center of the desk and thus my optimal mixing position (see Figure 4). I also connected its power cable.
3. I added the included rackmount brackets to the VS-700R and installed the interface into my rack just below my Sweetwater Creation Station rackXT DAW PC (see Figure 4). I also connected the VS-700R power cable.
4. I connected my various studio devices to the VS-700R, such as my main monitors to the monitor outputs, my surround monitors to outputs 1-6, my MIDI keyboard to the MIDI input, etc.
5. I connected the VS-700R to the VS-700C via the included proprietary cable. The only potential setback here (depending on your situation) is that the cable is only 10-feet long. That may seem quite long, but it's not. You lose some length because the connectors have to be attached straight into the units. So what it boils down to is that you'll need to keep both units fairly close together in your studio setup.
6. I installed the VS-700 drivers as per the instructions in the Getting Started guide.
7. I connected the VS-700R to the PC via the included USB cable and then powered up both units to complete the hardware installation.

Sweetwater Creation Station rackXT DAW PC

I recently upgraded my studio PC to a rackXT from Sweetwater – a very powerful machine with an Intel i7 quad-core chip, 6 GB of RAM, 1.5 TB of drive space, etc. If you're interested, you can find more information, ask questions, discuss, and post comments, as well as watch videos of the rackXT in action at: http://garrigus.com/?rackXT.
Setting up the Software
The VS-700 Getting Started guide also provides instructions for installing the included software. I basically kept to the guide with just a couple of differences as follows:

1. Before installing anything, I went to the Cakewalk website (www.cakewalk.com) and registered SONAR, Rapture, and Dimension Pro. That way I could unlock the software as soon as the installations were done without any hassles, since my DAW PC is not connected to the Internet.
2. I ran the VS-700 Software DVD, which copied the installer (VStudioSetup.exe) to my hard disk initially since I didn't have SONAR installed yet.
3. I ran the SONAR installation DVD, which proceeded to automatically install SONAR as well as the VS-700 software components, including: the SONAR VS-700 Control Surface Plug-in, the Fantom VS Editor, Rapture, and the Rapture Expansion Packs.
4. I installed Beatscape and Dimension Pro.
5. I ran SONAR for the first time, unlocked it and then followed the instructions on pages 23 – 31 in the VS-700 Getting Started guide.
6. I also ran Dimension Pro and Rapture to unlock them as well.
7. I shut down SONAR and restarted my PC.
8. I then installed the Beatscape 1.0.2 update, the SONAR 8.3.1 patch, and the SONAR Revision B Content patch – in that order.

These steps prepared the way for registering and updating the V-Studio 700 system.

Registering and Updating the V-Studio 700
At the time of this writing, there are two updates available for the V-Studio 700 – a 1.1.1 software update and a 1.1.0 firmware update for the VS-700R. To access the updates, you need to register your V-Studio 700 system via the Cakewalk website:

On that web page, you need to enter the appropriate information. The Name and Email fields are straightforward. For the SONAR V-Studio Software SN field, type in the SONAR serial number that was included in the V-Studio 700 package. For the VS-700C V-Studio Console and the VS-700R V-Studio I/O fields, type in the appropriate serial numbers. I mentioned where to find these earlier – they start with the letters ZX. For the VS-700 Kit Serial Number field, you need to type in a number from the box in which the system was packed – you didn't throw it away, did you? The number begins with the letters ZX and you can find it on one of the labels on the box, as shown in Figure 5.

Once you've registered, go to this page on the Cakewalk website:
SONAR 8.5, 8.5.1, 8.5.2, and 8.5.3 Updates
As a V-Studio 700 owner, you are also entitled to a free upgrade to SONAR 8.5. You should have received an email from Cakewalk about the upgrade. If not, you should contact them after you’ve registered your system on their site. The SONAR 8.5 upgrade comes as a download. With all the previous SONAR 8 updates installed, just install the 8.5 download upgrade, which will create a separate 8.5 installation while keeping SONAR 8.3.1 intact on your system. After that, be sure to download and install the 8.5.2 update (which also includes 8.5.1) and then the 8.5.3 update to have the most up-to-date system as of this writing.
2. Recording with the V-Studio 700

The V-Studio 700 provides a nice array of powerful features when it comes to recording audio. Not only does the VS-700R audio interface include a wide variety of professional connections (including clean and transparent mic preamps), it is actually very integrated into the entire system because of its ability to be controlled via the VS-700C control surface as well as from the SONAR software.

Setting Up for Sound with the VS-700R

Getting ready for a recording session always involves the usual tasks of setting up microphones and instruments as well as plugging everything into the audio interface. With the V-Studio 700, this situation is still the same, but the real fun begins when you start manipulating the VS-700R parameters.

Controlling the VS-700R Audio Interface

Pressing the I/O CONTROL button on the VS-700C puts the Control Surface into a special mode that allows you to control the eight mic/line inputs of the VS-700R. Each of the eight Channel Strips on the VS-700C (from left to right) controls each of the inputs (1 to 8), and the channel strip controls work as follows:

- **Encoder Button** – Press the rotary encoder to toggle the input’s digital compressor on/off.
- **Encoder Rotary** – Turn the rotary encoder to set the compressor gain. You can also press the Assign button to change the rotary function, which (by default) allows you to control the compressor threshold, attack, and release.
- **Mute Button** – Press the Mute button to toggle the input’s phase between normal and inverted.
- **Solo Button** – Press the Solo button to toggle the input’s –20dB pad on/off.
- **Arm Button** – Press the Arm button to toggle the input’s 100 Hz low cut filter on/off.
- **Channel Fader** – Adjust the fader to set the mic preamp gain.

Being able to control the audio interface parameters like this directly from the control surface does wonders for workflow. The only downside is that you can’t set the phantom power or compressor ratio (although you can change the rotary assignments to include the ratio instead of one of the other compressor parameters).

The V-Studio 700 Property Page

For full control of the interface, you need to use the V-Studio 700 Property Page, which can be opened via the SONAR Tools menu or by pressing COMMAND + I/O CONTROL on the VS-700C (see Figure 6).

The V-Studio 700 Property Page can be used to customize various aspects of the system. Under the MIC PRE tab, however, is where you’ll find the audio interface controls – these are for the inputs only because the output levels are set by pressing the MAIN button on the VS-700C and using the channel faders in conjunction with the FADER BANK buttons.
Additional functions that can be accessed via the Property Page (but not the Control Surface) include Sync and Digital 1 Input settings along with mic pre phantom power as well as the ability to link compressor controls if you’re using a pair of inputs for stereo. My favorite feature, however, is the Mic Pre Presets, which lets you save different input configurations. You can save settings for different mic setups, different instrument recordings, or even different singers and then instantly recall them for future sessions. Unfortunately, the phantom power setting isn’t saved, which is done for safety reasons, but I would like to personally see this as an option since I’m always very careful with my mic connections.

The Direct Monitor Mixer

The V-Studio 700 Property Page also gives you control of the VS-700R’s internal mixer via the DIRECT MIX tab (see Figure 7). The Direct Monitor Mixer can be used for a variety of tasks such as zero-latency recording or live session backup recording. The Mixer lets you adjust the mute, solo, pan, and level of every signal source (including the built-in Fantom VS synth) thus letting you create an entirely separate mix that does not pass through the computer. Instead, a stereo mix of all the signals can be routed to the Main, Sub, and/or Digital 1 outputs. Unfortunately, you can’t route to any of the individual outputs and the Mixer can’t be controlled via the Control Surface – at least not entirely.

Figure 7: Use the Direct Monitor Mixer for zero-latency recording.

Direct Monitor Mixer via the Control Surface

In SONAR, choose Tools > VS-700 to open the V-Studio 700 Property Page. Under the SURFACE tab (in the Alternate Encoder Functions section), you’ll see a representation of the I/O button. Listed under that button are the current four functions of the control strip encoder knobs. So when you press the I/O button on the Control Surface, the encoder knobs initially control Comp(ressor) Gain. Press the Assign button on the Surface, and the knobs then control Thresh(old), and so on. You can change these assignments by clicking on them and choosing new parameters from the menus. The DMix Pan and DMix Vol allow you to assign Direct Mix Panning and Volume to the knobs. Unfortunately, since there are only eight knobs, you can only control the first eight Direct Mixer channels (they can’t be banked like tracks in SONAR). Plus, by changing the knob assignments, you then lose the ability to control the previously assigned compressor parameters from the Surface. Hopefully, Cakewalk will find a different way to provide full Direct Monitor Mixer control from the Surface in a future update.

I’m definitely glad that Cakewalk included this feature though because the Mixer works great for zero-latency recording. At the lowest ASIO buffer settings, SONAR reports that my system has the following latencies: Input (6.3 msec, 277 samples), Output (3.2 msec, 140 samples), and Total Roundtrip (9.5 msec, 417 samples). These numbers are not a problem if you’re working with a small number of tracks, but once the track count starts growing, the latency starts to become noticeable. The only alternative is to either archive some tracks temporarily or record/monitor through the Mixer.
Using the Mixer for recording/monitoring is a simple process. To setup, you create your audio track and arm it for recording, but you leave input monitoring (Input Echo) off. Then you access the Direct Monitor Mixer and assign its output. Normally, you’ll want to send the signal to the Main output, but if you’re using the Sub output for a separate headphone mix, you may want to send it there instead. You can also just send it to both simultaneously, if needed. Finally, you adjust the fader corresponding to the input you’re using so you can hear the signal. When you record the track, the recorded audio will be in perfect sync with the rest of the project. Of course, the signal will be recorded/monitored dry so you can’t provide any basic reverb for vocal singers (for example) in this situation.

Recording in the Studio – Home and Pro
The V-Studio 700 works nicely in a variety of environments including both home and pro studios. By home, I mean a studio where everything is performed in one room. By pro, I mean a studio that has a least two separate rooms – one being the control room and the other being the recording space.

Recording in a Home Studio
When working alone in a home studio environment, a typical V-Studio 700 recording setup and session will probably entail having studio monitors connected to the Main monitor outputs on the VS-700R. While recording, monitoring is done through headphones connected to one of the Phones outputs on the VS-700C. In addition, microphones and instruments are connected directly to the back of the VS-700R.

Fan Noise and Footswitches
If you’re recording with a microphone in the same room as your studio equipment, you may pick up fan noise from the VS-700R. It’s not very noisy, but it is definitely audible. One thing you can do is use acoustic gobos to section off a part of the room to act as a makeshift recording booth. In addition, you can get an extension cable for your headphones and use the footswitches on the VS-700C (or just use a wireless computer keyboard) to control SONAR remotely.

You may also be interested in the Portable Vocal Booth from RealTraps. This device mounts on any microphone stand to create a highly controlled environment for recording vocals and spoken narration. You can find more information (and get a 10% discount) by going to the RealTraps section of the DigiFreq Deals web page: [http://digifreq.com/?MusicDeals](http://digifreq.com/?MusicDeals)

With everything set up and a project loaded in SONAR, the steps for recording audio with the V-Studio 700 might go as follows:

1. Press CTRL + TRACK on the VS-700C to insert an audio track.
2. Press the ASSIGN button to set the channel encoders so that they control track output. Then make sure the track is set to either the VS-700R Main outputs or to a master bus that is set to the Main outputs. Also, do the same thing to set the track input so that it matches the input you are using on the VS-700R.

www.garrigus.com / www.cakewalk.com
2. Recording with the V-Studio 700 - 13

**Use Friendly Audio Driver Names**
When setting inputs/outputs via the VS-700C, you might find it a bit difficult to find the correct value because of the size of the LCD display provided for each channel. To get around this problem, choose Options > Audio in SONAR and click the Drivers tab of the Audio Options dialog box. At the bottom of the box, put a checkmark next to the Use Friendly Names To Represent Audio Drivers option. Then double-click the name of each input and output in the Friendly Name column of the Drivers lists and type in a new name for each driver. I chose to delete the VS-700 label from all the names and shorten DIGITAL to DIG. After doing this, I found it much easier to see which inputs/outputs were being displayed on the LCD of the VS-700C.

3. Press and hold the SHIFT button and press the MUTE button on the Channel Strip for the track to turn on Input Echo. Keep in mind that monitoring via Input Echo will send the signal through SONAR while recording. If your project starts to increase in size and you have a problem with latency, you can use the Direct Monitor Mixer as described earlier in this chapter.

4. If you want to hear effects while recording, you can insert plug-ins into the FX bin of the audio track either via SONAR or by using the VS-700C. Check out the SONAR VS-700 Control Surface help file in the section entitled “Controlling plug-ins from the SONAR VS-700C surface” (or read Chapter 5 of this eBook) for more information. If you use the Direct Monitor Mixer, you can’t monitor with effects.

5. Press the MUTE button in the Audio Output section of the VS-700C to mute the studio monitors.

6. Adjust one of the Phones knobs to set your headphones level.

7. Press the I/O CONTROL button and with your headphones on, use the Channel Strip fader to adjust the input level of the audio channel you’re using. If you’re recording with a microphone, keep in mind that the –20dB pad for all channels is on by default, so if you’re not getting a good signal, press the SOLO button to turn the pad off. Also, if you need phantom power, you’ll need to turn that on with your mouse via the VS-700 Property Page.

8. Press the ARM button of the Channel Strip to arm the track for recording.

9. Use the Jog/Shuttle wheel (and/or Transport controls) to position the Now Time to the point in the project where you would like to start recording.

10. Press the RECORD button in the Transport section of the Control Surface. Then listen to the metronome and record the track.

11. Press the STOP button in the Transport section and SONAR will reposition the Now Time to the beginning of the newly recorded clip.

12. Press the PLAY button to listen to the performance.

13. Press the UNDO button in the Project section if you don’t like the recording and then record the track again.

14. If you like the track, press the SAVE button in the Project section to save the recording.

Repeat the process to continue building up the project. In addition, you can control loop recording as well as punch recording via the VS-700C (see the VS-700C help for more information).
Recording in a Pro Studio
When working in a professional studio environment, the V-Studio 700 system is set up in a control room where the recording engineer controls and monitors the session. Microphones and instruments are set up in another room that acts as a recording space. The connections on the VS-700R are attached to jacks mounted in the wall that allow the signal to pass through to jacks on the other side of the wall. Another scenario might have the VS-700R connected to a mixing console with the console channels being patched through the wall. Other than that, the steps for recording are basically the same as with the home studio situation. However, there are some differences when it comes to monitoring (as well as communicating with the musicians).

Monitoring in a Pro Studio
A basic monitoring scenario with the V-Studio 700 in a pro studio would have the studio monitors connected to the Main monitor outputs on the VS-700R. In addition, there would be a headphone amp connected to the Sub monitor outputs, which would be used to provide a separate mix for the musician(s) in the studio or recording booth. This would let the engineer have his own monitor level and mix in the control room, while providing each musician with their own headphone level (although they would all have to share the same mix).

To configure this scenario in SONAR, you would use the V-Studio 700 Property Page to access the Direct Monitor Mixer (as I described earlier in this chapter) and send its output to the Sub monitor output. You would also need to create a send on each track and either route the sends directly to the Sub output or (more traditionally) to a bus designated as the headphone mix, which is then routed to the Sub output. Sends for each track can be controlled via the VS-700C using the CHANNEL STRIP CONTROL section by pressing the SEND button and adjusting the appropriate knobs. I'll talk more about this in Chapter 5.

Now if you wanted to give each musician his/her own separate headphone mix, that's also possible since the VS-700R provides 10 outputs (or 5 stereo pairs). You would just need a headphone amp with multiple inputs. The only problem with this situation is that monitoring would have to be through SONAR, rather than through the Direct Monitor Mixer. This could eventually cause problems with latency depending on the number of tracks you’re working with, but I wanted to be sure and mention that it is something that’s possible with the V-Studio 700 system.

What About Talkback?
One other problem that will come up in a professional studio environment is finding a way for the engineer to communicate with the musicians. Normally, this is done via a talkback function provided on most professional mixing consoles. If the studio already has one in place, then you’re all set. If you don’t plan to use a console or your console doesn’t have the feature, you would normally be out of luck because the VS-700C is essentially a control surface (not a mixing console) and it doesn’t provide a talkback feature.

If you’re working with only one musician, you could sort of get around this issue by just purchasing a pair of walkie-talkies (two-way radios) – both Cobra (http://garrigus.com?CobraRadio) and Motorola (http://garrigus.com?MotorolaRadio) have some nice products. However, that might not go over too well with clients and a more traditional approach would be easier to work with.
As such, I came up with a workaround that does have a couple of drawbacks but still works very nicely and can be fully controlled via the VS-700C. Here’s how to set up a talkback feature with the system:

1. Setup a microphone in the control room and connect it to one of the mic inputs on the VS-700R. Yes, this does use up a mic input, but if you need to record more than seven microphone tracks simultaneously, you can always add eight more mic inputs by connecting a preamp to the digital input or adding another VS-700R to the system. For this example, let’s say the mic is connected to input 8.

2. As I mentioned in the previous section, you will probably want to set up a separate bus for the headphone mix with the output going to the Sub monitor outputs of the VS-700R. You’ll also want a master bus routed to the Main monitor outputs. So that’s the scenario we’re working with in this example.

3. In SONAR, create an audio track that will be used for talkback (see Figure 8). The track input is set to Right IN 7-8 and the output is routed to the headphone mix bus.

4. Make sure the Input Echo for the talkback track is turned on so that the microphone signal is echoed to the headphone mix. Then open the V-Studio 700 Property Page and use the controls under the MIC PRE tab to set the input level for input 8. You may need to turn the –20 dB pad off and the phantom power on, depending on the mic you’re using.

5. Press and hold SHIFT on the VS-700C and then press the SEL button of the Channel Strip that corresponds to the talkback track. What this does is lock the Channel Strip to the track in SONAR, so even if you change fader banks, the Channel Strip will still control the track. Yes, this leaves you with only seven faders to work with, but only during recording. When it comes time to mix, you won’t need the talkback function. By the way, the LCD for the Channel Strip will put an asterisk at the end of the track name, so you’ll be able to easily see which strip to use for talkback.
6. Now the key to making this work (and not creating a feedback loop) is the mute buttons for both the talkback track and master bus. Initially, you want the talkback mic to be off and the studio monitors to be on. To set this up, mute the talkback track and make sure the master bus is not muted.

7. Group the tracks by right-clicking their mute buttons in SONAR and choosing Group > A (we'll use group A for this example, but you can use any group you want).

That should do the trick. Now when you press the MUTE button on the Channel Strip that is assigned to the talkback track, the track is unmuted and the master bus is muted. This means the talkback mic is on and the musicians can hear you in the studio. If you want to hear them, press the MUTE button again and have them speak into their studio microphones. The grouped mute buttons on the track and master bus work the way they do because their group starting and ending values are swapped (as you can see in the Group Manager dialog box shown in Figure 9). You can open the Group Manager dialog box by right-clicking a track/bus mute button and choosing Group Manager.
3. Composing with the V-Studio 700

Depending on how you do things, the V-Studio 700 can save you a lot of time when it comes to your workflow. It has definitely done that for me (in varying degrees) with every stage of song development. In terms of composition, I’ve found that the system has made the least amount of difference mainly due to the fact that you still need the use of the computer mouse when working with individual MIDI notes, such as in the Piano Roll view or the Staff view. This is also the case when working with loops via the Media Browser. However, if you do most of your composing by recording real-time (or step-time) performances via your MIDI keyboard, you’ll definitely find some advantages to having the V-Studio 700 on hand.

Working with MIDI Tracks

When composing music in SONAR, I usually start with a special project template (see the next section entitled “Working with the Roland Fantom VS Synthesizer”) or a blank project and build things up by inserting track templates and/or soft synths. By having my default project template set up without any tracks and with the recording metronome ready to go, all I have to do is set the tempo and I’m ready to roll.

MIDI Track Setup

Inserting track templates usually has to be done either with the mouse or computer keyboard. I try to restrict my use of the mouse as much as possible so I usually press ALT + I + N on the computer keyboard and then use the arrow keys to choose a template. The arrow keys on the VS-700C (located around the Jog/Shuttle wheel) work for navigating menus as well, but to initially open a SONAR menu you need to use the PC keyboard or mouse.

Track Templates via the VS-700C

Technically, there is a way to insert a track template from the Control Surface, but I find it to actually be more cumbersome than just using the PC keyboard. You can assign a key binding in SONAR to the Import Track Template function in the Track View Bind Context of the Key Bindings dialog box. You can then assign that key binding to one of the buttons in the Access Panel section of the Surface (see Customizing the Access Panel in Chapter 4). The thing I don’t like about this situation is that one of the default Access Panel functions has to be given up. Plus, this scenario displays the Import Track Template dialog box, which is actually more difficult to navigate than the Insert From Track Template menu (especially if you create a track template folder called 1Favorites, which positions that folder at the top of the menu for quick access).

Inserting new MIDI tracks can easily be done via the VS-700C by pressing CTRL + ALT + TRACK in the ACCESS PANEL section. However, changing the channel, bank, and patch parameters has to be done with the mouse (or a PC keyboard via SONAR’s Tracks > Property menu). Inserting soft synths can be done with a combination of the VS-700C and a PC keyboard (or just the keyboard alone). Press the SYNTH RACK button in the ACCESS PANEL section of the VS-700C to open the Synth Rack view, then press A on your PC keyboard and use the arrow keys to navigate the menu and the Insert Soft Synth Options dialog box. Once open, a soft synth’s patches have to be selected via the mouse.
Simple Instrument Tracks for Soft Synths

When I know that I’m going to be using a single stereo output from a soft synth, I’ll use the Simple Instrument Track option in the Insert Soft Synth Options dialog box. Some people argue that Instrument tracks don’t provide enough flexibility when using soft synths because many of the audio parameters are inaccessible. However, for V-Studio 700 users, this is not entirely the case. Even though the EQ and Send parameters of Instrument tracks are hidden in the SONAR interface, they are easily accessible via the VS-700C. In addition, having fewer tracks in the Track view makes navigation easier with the Control Surface. There are, however, some limitations – you can’t access the Volume Trim parameter or access the track in the V-Studio 700’s Channel Branch mode (I’ll talk more about that in Chapter 5). In addition, while the track FX bin does allow you to insert audio effects via the mouse, you can’t do it with the Control Surface. Instead, the Surface only allows you to insert MIDI effects for Simple Instrument Tracks.

MIDI Track Recording

While the V-Studio 700 isn’t much help in regards to MIDI track setup (audio track support is far better), using the system to record and play MIDI tracks is a very smooth process. Everything can be done using the VS-700C, as follows:

1. Press the SEL (Select) button of the Channel Strip for the track you want to record. This selects the track and makes sure the data from your MIDI keyboard is being echoed to the appropriate synth.
2. Press the ARM button of the Channel Strip to arm the track for recording.
3. Use the Jog/Shuttle wheel (and/or Transport controls) to position the Now Time to the point in the project where you would like to start recording.
4. Press the RECORD button in the Transport section of the Control Surface. Listen to the metronome and record the track.
5. Press the STOP button in the Transport section and SONAR will reposition the Now Time to the beginning of the newly recorded clip.
6. Press the PLAY button to listen to the performance.
7. Press the UNDO button in the Project section if you don’t like the recording.
8. Press the SAVE button in the Project section to save the recording.

That’s the entire process – quick, simple and very intuitive. You can really build up a project quickly by pressing a few buttons and recording tracks in real-time.

Working with the Roland Fantom VS Synthesizer

One of the biggest changes to my compositional workflow was the addition of the Roland Fantom VS Synth. Like some other Cakewalk users, I was at first a bit skeptical as to whether or not I would actually need the Fantom VS. Some have argued that it would have been better to leave the Fantom out of the system in order to reduce the cost. However, now that I’ve actually had a chance to try it, I find myself using it in almost every project. Why? The answer is simple… the Fantom VS can be easily accessed just like a soft synth, but provides no hit on the CPU (just like a hardware synth). In addition, it’s not just a basic feature that was thrown in as a bonus. The Fantom VS is a high-quality synthesizer that not only provides over 1,400 built-in patches, but also the ability to create your own patches with access to 1,240 tone waveforms and an arsenal of editable parameters.
My Fantom VS Song Project Template

When composing a new song from scratch, I like to get up-and-running quickly so that I don’t lose that creative inspiration while setting up a new project. As I mentioned earlier, I sometimes start with a blank project, but many times I’ll use a special Fantom VS project template to get things rolling. The Fantom VS works great when laying out scratch tracks for a song because it provides so many common (and uncommon) sounds, which are all categorized by type.

**The Fantom VS Template Tracks**

As you can see in Figure 10 (click it to see the entire picture), I have seven MIDI tracks inside a Fantom VS track folder. Each track is labeled with a generic instrument name, but is set to a specific Fantom VS patch in a related category. You’ll also notice that I have a Session Drummer 3 folder containing a single MIDI track and multiple audio tracks (one for each of the SD3 stereo outputs). Although the Fantom provides a variety of good sounding drum kits, I like using SD3 because of its flexibility, multiple outputs, and excellent new included kits.

Another reason I’m using SD3 for drums and limited myself to seven Fantom MIDI tracks is that the Fantom has a 128-voice polyphony, which is quickly consumed depending on what patches you use. I’ve found that I rarely need more than seven instruments (plus drums) to initially sketch out a song. Moreover, I can always add more tracks or simply use some other VST instruments, which is what usually happens when I’m done with a sketch and want to replace some of the Fantom tracks.

**Working Around the Polyphony Problem**

Another way around the voice limit is to simply bounce some of the Fantom MIDI tracks to audio, if necessary. To do that, select a single MIDI track as well as the Fantom audio track. Then choose Edit > Bounce To Track(s) and use the Raw Tracks preset in the dialog box. Because of the Fantom’s single stereo output, however, you can only bounce one MIDI track at a time. In addition, because the Fantom is a hardware synth, you have to do a real-time bounce. Remove the checkmark next to Fast Bounce and add a checkmark next to Audible Bounce in the dialog box.

**Controlling the Tracks from the VS-700C**

A few others things you’ll notice about the template is that track 8 seems to be missing and I’ve also set up three buses – one each for Fantom VS, Drums, and Master audio output. Of course, it’s standard procedure to use buses for grouping track outputs, but in this case I had an even more important reason... easy track and bus control from the VS-700C control surface.
The VS-700C provides eight channel strips and when a project is first opened, those eight strips are automatically assigned to the first eight tracks. Since I have seven Fantom MIDI tracks and one SD3 MIDI track, I wanted them grouped together to be the first bank of eight tracks. To do that, I decided to hide track 8 (the Fantom audio output track). There’s no need to have access to that track, because all Fantom sounds come out of that same output and all processing is done inside the Fantom itself. I did want to be able to control the volume of the track though, so I simply sent it to a dedicated bus. Problem solved.

Hiding Tracks from the Control Surface
In the default configuration, hidden tracks can still be “seen” by the VS-700C. In order to synchronize track visibility between SONAR and the Control Surface, choose Options > Controllers/Surfaces. Then in the dialog box, select the VS-700 in the list and choose Track View for the Control Strips Visible In parameter.

This works perfectly because now when the template is opened, the first eight tracks are automatically assigned. All I have to do is set the tempo and start composing/recording. If I want to control any of the individual drum outputs, I use the FADER BANK buttons on the VS-700C. If I want to control the overall output of the drums or the Fantom VS I use the FADER VIEW BUS button. Plus, I always have access to the Master bus via the Master fader on the Surface.

Tweaking the Fantom VS Patch and Mixing Parameters
While I was happy with that initial template setup, I wanted to take it a step further. For audio tracks, the VS-700C lets you controls aux sends via its CHANNEL STRIP CONTROL section. For MIDI tracks, that same section lets you adjust Chorus and Reverb parameters – press SEL to select a MIDI track, press the Send button in the CHANNEL STRIP CONTROL section and make sure the Display is set to the first row. The first two knobs now control the Chorus and Reverb parameters, respectively. However, these don’t always work. It depends on what soft synth you’re using. The Fantom VS requires a bit of tweaking, as follows:

1. Open the Fantom VS Editor and click the Controls – Mixer button to display the Fantom VS Mixer (see Figure 11).
2. Set all the Chorus knobs to 127.
3. Set all the Reverb knobs to 127.
4. Set all the Output menus to L+R (see Appendix B for some additional information about setting the Output menus).
5. Set all the Level knobs to 127.
6. Set all the Level faders (including the Master Level fader) to 127.

Making these settings allows you to control the Chorus, Reverb, and Volume of each Part directly from the Track parameters via the VS-700C control surface. See Appendix B for some additional information about the Fantom VS Chorus and Reverb FX.
Fantom VS Song Template for SONAR
If you would like to take a look at the template I’ve created in more detail or even use it as a starting point for your own projects, you can download a free copy at: http://digifreq.com?FVSTemplate. All I ask is that you give me half ownership in any song that you create using this template. Just kidding! It’s totally free to use. By the way, please keep in mind that my choice of patches for each of the seven tracks isn’t permanent. I have yet to try out all 1,400+ sounds provided by the Fantom so in that respect, the template is still a work in progress.

Composing with Synth Parameter Automation
Many times when composing with synth sounds, I’ll use presets because I like them and they fit well in the current project. However, to keep them from sounding like presets, I like to make them more dynamic using parameter automation. The V-Studio 700 provides quick and easy synth parameter control and automation through SONAR’s ACT functionality. The T-Bar on the VS-700C can be used to control a single ACT parameter and I like to use this when I need very smooth parameter changes.

There’s also the CHANNEL STRIP CONTROL area where all of the other ACT controls reside. This area provides 12 physical knobs and 4 buttons along with 4 virtual pages for control over 64 assignable parameters. Unfortunately, the motorized channel faders can only be used to control/record track parameters – it would be nice to see this upgraded for synth parameter control in a future update. There’s just something about the touch sensitivity and motorized capability that makes me want to use the faders for all automation recording.

In the meantime, the combination of the CHANNEL STRIP CONTROL knobs and the T-Bar works very nicely. When you press the ACT button for either section, the controls automatically assign themselves to the parameters for the currently active synth. Of course, these can easily be changed using the onscreen ACT button inside the synth property page window and tweaking the controls. Then it’s just a matter of selecting a track (SEL button on VS-700C), turning on automation write (AUTOMATION WRITE/OFF button on VS-700C), and then recording the automation.

The Synth Rack View
Personally, I like to use the Synth Rack view when recording synth automation because of several advantages it provides as follows:

- It allows you to choose the track to which automation data is recorded. Normally this is the synth track itself, which works great using a single instance with a single MIDI track. But when you’re using a mult timbral synth (like the Fantom VS), recording the data to the individual MIDI tracks is much more organized.

Figure 12: Use the Synth Rack view for synth automation recording.
You can assign onscreen controls for each soft synth, which lets you see all control assignments at once (see Figure 12). For example, I have my 12 favorite control assignments done for each synth corresponding to the 12 knobs on the control surface. That way I can see all twelve knob assignments without having to page through them on the VS-700C LCD display. Plus, control assignments in the Synth Rack view are automatically saved (even for use in different projects).

The onscreen controls also allow you to group multiple parameters. With grouped parameters, you can record more than two automation controls at the same time even though you can only tweak two Control Surface knobs simultaneously because you only have two hands.

The Synth Rack also lets you arm automation for an entire synth no matter how many MIDI tracks are driving it, and there’s no need for selecting tracks in the Track view or arming individual tracks.

The only disadvantage to this scenario is that you’ll need to use a mouse to access some parts of the Synth Rack view. Even so, it’s a joy to be able to access everything in one view, have all control assignments right there on the screen, and to be able to easily record synth parameter changes with physical knobs and buttons.
4. Editing with the V-Studio 700

When the composing and recording phases of a project are completed, the arranging and editing phase usually comes next. The V-Studio 700 provides a huge number of editing features, but only in SONAR’s Track view. If you need to work with MIDI data in the Piano Roll, Event List, or Staff views, you’ll still need to rely on your mouse and PC keyboard. As far as arranging and editing clips in the Track view is concerned, however, you can do almost anything directly from the VS-700C without touching your PC peripherals.

Shortcuts and Quick Keys Guide
Throughout this chapter, you’ll find a wide variety of command functions and control shortcuts discussed as I present the many editing features provided by the V-Studio 700 system. Those of you who are reading about the system for the first time or are new users may find some of the information a bit intimidating. While learning to use some of the more advanced features can take some time, overall, using the system is a very intuitive process. In addition, Cakewalk has been kind enough to include a Shortcuts and Quick Key Guide that is clearly organized by topic and provides easy access to the functions and control shortcuts used by the system.

Modes of Operation
The VS-700C provides a number of modes in which you can work. All of these modes use the Jog/Shuttle wheel (and its arrow buttons) along with other button combinations to carry out different operations.

Transport Mode
In the Transport (default) mode, the Jog/Shuttle wheel controls the Now Time. Turn the wheel left/right to move the Now Time towards the beginning/end of a project, respectively. The up/down arrow keys change the active track and the left/right arrow keys move the track parameter cursor (the white outline around the active track parameter). Of course, the Transport buttons work as expected and maintain their functions no matter what mode is currently being used. The Transport mode is best used during recording and mixing. You don’t really need it during editing, as I’ll explain later.

Scroll Mode
To activate Scroll mode, press the SCROLL button on the Control Surface. In this mode, SONAR’s Free Edit Cursor is activated and displayed as a blinking, vertical white line (with a magnifying glass attached to it) inside a track (see Figure 13).

Turn the Jog/Shuttle wheel right/left to move the Free Edit Cursor toward the beginning/end of a project, respectively. The left/right arrow buttons do the same. The up/down arrow buttons will move the Cursor vertically in the Track view, which also scrolls the Track view vertically if you are dealing with a long track list.

Figure 13: Scroll mode uses the Free Edit Cursor to navigate in a project.
Keep in mind that the Free Edit Cursor moves independently of the Now Time. So even if you move the Cursor to a certain location in a project, playback will still start at the Now Time, which can be located at a different point along the timeline.

**Fly Over and Other Extended Functions**

A third way that you can move through a project (that is independent of both the Now Time and the Free Edit Cursor) is the Fly Over (horizontal scroll) function. In Scroll mode, press and hold the SHIFT + COMMAND buttons while turning the Jog/Shuttle wheel. This allows you to view other parts of a project while keeping the Now Time and Free Edit Cursor at their current locations.

Also, keep in mind that all of the modes explained in this chapter have alternate functions available by using the modifier keys in the ACCESS PANEL section of the Control Surface. To see all the combinations that are available, open the VS-700 Property Page (via the Tools menu in SONAR) and press F1 to access the VS-700 Control Surface help. Under the Contents tab, choose Using the VS-700C Control Surface with SONAR > Playback, looping and locating/navigating.

**Zoom Mode**

To activate Zoom mode, press SHIFT + ZOOM (same as SCROLL button) on the Control Surface. Like in Scroll mode, SONAR’s Free Edit Cursor is displayed. Turn the Jog/Shuttle wheel right/left to zoom in/out horizontally, respectively. You’ll notice that the zoom is centered on the Cursor, which allows you to zoom in on a specific point very easily. To scroll vertically, press and hold the CTRL button while turning the Jog/Shuttle wheel. Keep in mind, however, that this only zooms the individual track containing the Free Edit Cursor. If you want to zoom the entire Track view vertically, you’ll need to use the global vertical zoom function (see Global Functions tip below). Of course, the Jog/Shuttle arrow buttons can also be used and you can even access scrolling and Fly Over functions via modifier keys (see the section of the VS-700 help that I mentioned previously).

In addition, three special zoom commands are provided as follows:

- **Zoom Undo** – Press COMMAND + UNDO (located in the PROJECT section) to undo the last zoom operation.
- **Zoom Redo** – Press SHIFT + COMMAND + REDO (same as the UNDO button) to redo the last zoom operation that was undone.
- **Fit To Project** – Press COMMAND + SET (located in the RECORD/EDIT section) to fit all clips in a project into the current Track view layout.
- **Fit Selection** – Press ALT + SET to fit the current selection into the Track view layout.

**Global Functions**

Previously, I mentioned the Fly Over (horizontal scroll) and vertical scroll functions, as well as horizontal and vertical zoom. Normally, you would access these functions via their respective modes, however, the VS-700C also lets you access them globally. No matter what mode you are using, you can use SHIFT + COMMAND or CTRL + SHIFT + COMMAND (along with the Jog/Shuttle wheel) to scroll horizontally/vertically, respectively. In addition, you can use COMMAND or CTRL + COMMAND (along with the Jog/Shuttle wheel) to zoom horizontally/vertically, respectively. Keep in mind, however, that zooming with this global function does not center the zoom at the Free Edit Cursor as it does in Zoom mode, so it’s not quite as useful.
Select Mode
You can activate Select mode in one of two ways – Select By Time (press SELECT) or Select By Clip (press SHIFT + SELECT). Personally, I find it best to just use Select By Time since you can access clip selection from this mode using modifier keys, which I’ll explain shortly. Like in the Scroll and Zoom modes, SONAR’s Free Edit Cursor is displayed (this time with a pointed cross attached to it) and you can freely move the cursor using the Jog/Shuttle wheel (and arrow buttons). You can also quickly move the Cursor either to the center of the Track view or to line up with the Now Time by pressing CTRL + SELECT or ALT + SELECT, respectively.

To make a time selection, hold down the ALT button and rotate the Jog/Shuttle wheel or use the arrow buttons. To select vertically with the Jog/Shuttle wheel, hold down CTRL + ALT. Keep in mind that the degree of time selection is controlled by the Snap To Grid, which you can turn on/off with the SNAP button (although, to adjust Grid settings, you’ll still need your mouse).

To make a clip selection, hold down the SHIFT button and rotate the Jog/Shuttle wheel or use the arrow buttons. To select vertically with the Jog/Shuttle wheel, hold down CTRL + SHIFT. Unfortunately, one major drawback to selecting with the Control Surface is that the data has to be contiguous or all in one clip… meaning, you can have only one block of time or one clip selected simultaneously. You can’t select multiple clips in different parts of a project (as shown in Figure 14) – that still needs to be done by holding Ctrl on your PC keyboard and clicking multiple clips with your mouse.

Finally, to clear a selection with the Control Surface, press and hold the LEFT FLAG button and press the RIGHT FLAG button (see Figure 15). If you don’t clear a selection, it will remain intact even if you switch out of Select mode, which brings us to Edit mode.

Edit Mode
Once you’ve made a selection, you can enter Edit mode by pressing the EDIT button on the Console. Different editing functions are available depending on the type of selection – time or clip.

Editing Selected Time
As soon as you enter Edit mode, the selected data can be moved (nudged) or processed. Pressing the Jog/Shuttle up/down arrow buttons will move the data to a different track (or tracks, depending on the selection). Pressing the left/right buttons or turning the wheel, will move the data horizontally using SONAR’s Nudge 1 resolution. If you hold SHIFT or CTRL (while turning the wheel), the Nudge 2 and 3 resolutions are used, respectively. Of course, you’ll need to setup the Nudge resolutions from within SONAR. Personally, I like to keep one of them set to follow the Snap To Grid value, and use specific values for the others (usually 1 sample and 1 frame). See Appendix B for some additional information about working with time selections.
In addition to moving the selected data, you can perform a number of processing functions via the buttons in the ACCESS PANEL section of the Control Surface. Specifically, you can use CUT, COPY, PASTE, DELETE, FADE, and SPLIT. CLIP MUTE can only be used when entire clips are selected, and FREEZE is for freezing the entire selected track (which doesn’t really pertain to editing). The CUT, COPY, PASTE, DELETE, and SPLIT functions all happen immediately – as soon as you press one of the buttons, the associated function is performed. The FADE function, however, first displays the Fade Selected Clips dialog box, where you can adjust the parameters with your mouse or PC keyboard. In addition, the fades are applied to the clip edges even if you only have a portion of a clip selected. If you want the fades to be applied to the selection, you need to use the SPLIT function first. Keep in mind that you can directly fade the edges of clips without the dialog box when editing individually selected clips, as described in the next section.

### Customizing the Access Panel

If you would rather have different functions available for editing via the Control Surface, you can customize the buttons in the ACCESS PANEL section. To do so, in SONAR choose Tools > VS-700 and click the SURFACE tab in the V-Studio 700 Property Page. In the Access Panel section of the page, click the function shown underneath a button. In the Button Properties dialog box, you can choose to have that button launch a SONAR host command, a specific keystroke, or a transport command. Unfortunately, you are limited to one function per button – you can’t use the SHIFT, CTRL, ALT or COMMAND modifier buttons (on the Control Surface) in conjunction. You can save multiple Property Page presets (allowing you to save different Access Panel configurations) but you still need to use a mouse to change presets. Hopefully, Cakewalk will improve this functionality in a future update.

### Editing Selected Clips

When working with a selected clip, all the previously discussed functions work (except for SPLIT, since a clip already has defined edges). In addition, there are some special functions that can only be applied to a selected clip. These functions include Crop, Fade, and Time Stretch. To perform any of these functions, first chose which edge of the clip (left or right) you want to edit by using the LEFT FLAG and RIGHT FLAG buttons, respectively (see Figure 15). Depending on which edge you choose, the Free Edit Cursor will display with a left or right bracket symbol – and you can switch edges at any time to easily perform changes to both while in Edit mode.

To crop a clip, simply use the Jog/Shuttle wheel (or its left/right arrow buttons). The amount of cropping applied depends on the Snap To Grid settings. To fade a clip, press and hold SHIFT while using the wheel or buttons. Keep in mind that depending on what edge you’re fading, the left/right buttons will work differently. For example, when fading the left edge, press left to decrease the fade and right to increase it – and do the opposite with the right edge. To time stretch a clip, press and hold CTRL while using the wheel or buttons. Like with cropping, the amount of stretching applied also depends on the Snap To Grid settings.

### Quick Selection Audition

No matter what mode you are in, you can quickly audition any selected data by pressing and holding SHIFT while using the PLAY and STOP transport buttons. This is especially useful while editing so you can easily hear the changes you have made without hearing all the other tracks in a project. Plus, this feature doesn’t disturb the position of the Now Time, which automatically returns to its original location as soon as the selection is done playing or when you press STOP.
4. Editing with the V-Studio 700 - 27

Mode Combinations for Workflow
As you can see, the V-Studio 700 provides a wide array of functions for editing data via the Console. At first, you may take the typical route by using the modes during editing as follows:

1. Use Transport (and/or Scroll) mode to find a project section that needs some tweaking.
2. Use Zoom mode to zoom in on a specific piece of data.
3. Use Select mode to select the data to be edited.
4. Use Edit mode to edit that data.

However, as you continue to work with the System, you'll come to find that not every mode is essential, and you can save time by developing a more concise workflow when accessing the various editing functions. I have found that the V-Studio 700 provides a high level of versatility, which allows you to work with the System in your own way rather than making you conform to a certain set of rules.

Finding Data to Edit
Personally, I find that I hardly ever need the Transport or Scroll modes during editing. Why? Because the functions provided in those modes are easily accessed from Select mode, which is the mode I use by default.

Controlling the Now Time
Using a combination of the Control Surface’s transport buttons, FLAG buttons, and my PC keyboard, I have full control over the Now Time in Select mode – the same degree of control provided by Transport mode.

- The RIGHT/LEFT FLAG buttons (see Figure 15) move the Now Time to previous/next markers in a project, respectively.
- The beginning and end transport buttons move the Now Time to the beginning or end of a project.
- The rewind and fast forward transport buttons move the Now Time along the Time Ruler in a project, which is the same as turning the Jog/Shuttle wheel in Transport mode.
- Pressing Ctrl + PageUp or PageDown on the PC keyboard moves the Now Time to previous/next measures, respectively. This is also the same as pressing the Jog/Shuttle left/right arrow buttons in Transport mode.

Controlling the Free Edit Cursor
In Scroll mode, you can use the Jog/Shuttle wheel (and/or its arrow buttons) to control the position of the Free Edit Cursor, but you can do the exact same thing in Select mode. Another advantage of moving the Free Edit Cursor in Select mode is that it follows the Snap To Grid settings – it doesn’t do this in Scroll mode.

Independent Navigation
In addition, as in both Scroll and Zoom modes, you can easily scroll the Track view in Select mode independently of the Now Time or Free Edit Cursor locations using the global Fly Over functions, as follows:

- Horizontal scrolling – press and hold SHIFT + COMMAND while using the Jog/Shuttle wheel or its arrow keys.
- Vertical scrolling – press and hold CTRL + SHIFT + COMMAND while using the Jog/Shuttle wheel or its arrow keys.
Zoom Mode or Not?
Deciding whether or not to use Zoom mode is a bit trickier since there is a possible advantage to it. In Select mode, you can use the global functions for zooming, as follows:

- To zoom horizontally, press and hold COMMAND while using the Jog/Shuttle wheel or its arrow buttons.
- To zoom vertically, press and hold CTRL + COMMAND while using the Jog/Shuttle wheel or its arrow buttons.

You’ll notice, however, that the screen may drift to the left or right while zooming and won’t stay centered on the Free Edit Cursor. The display does stay centered in Zoom mode. Nevertheless, this isn’t really a major problem because during zooming, the Free Edit Cursor remains stationary. Thus, once you’re done zooming, you can move the Free Edit Cursor by one step of the wheel (or press of a button), which will automatically bring it into sight in the Track view. You can then move the Cursor back by one (in the opposite direction) and you’ll be at the exact spot you need for editing. In addition, the special zoom commands (explained earlier in the Zoom Mode section of this chapter) continue to work in Select mode. So again, you don’t really need to use Zoom mode for zooming.

Data Selection Shortcuts
Two more time-saving procedures you can use to improve your workflow pertain to clip selection. As discussed earlier, Select mode provides two methods of operation: Select By Time and Select By Clip. Personally, I like to use Select By Time by default and access Select By Clip using the SHIFT modifier button. This way I don’t have to waste any time switching back and forth between methods.

In addition, if you know that you’re going to be editing an entire clip in Edit mode, there’s no need to select the clip. While in Select mode, simply position the Free Edit Cursor anywhere inside the clip. Then press the EDIT button to enter Edit mode and the clip will be automatically selected – immediately ready to be edited.

Optional Editing Workflow
Finally, you may find that you need not exit Select mode at all for some editing tasks. Why? Because once you’ve made a data selection, many of the same processing functions that are available in Edit mode are also available in Select mode. The CUT, COPY, PASTE, DELETE, FADE, CLIP MUTE, and SPLIT functions in the ACCESS PANEL section of the Control Surface can all be used from within Select mode. As a matter of fact, the SPLIT function actually provides an extra bonus when used in Select mode – if you press SPLIT when there is no data selection, a split will occur at the Free Edit Cursor location (which can’t be done in Edit mode).

Therefore, as you can see, you can have a more efficient editing workflow by doing most tasks from within Select mode and switching to Edit mode whenever necessary (i.e. for nudging, cropping, fading and time stretching clips). Using the procedures discussed in this chapter can save you a lot of time, especially when you’re on a deadline.
5. Mixing with the V-Studio 700

One of the most important aspects of the music making process is mixing and the V-Studio 700 provides a full arsenal of features to enhance your workflow. These features include eight bankable channel strips with motorized (and touch sensitive) faders, the ability to control sends and buses, the ability to apply per track EQ, the ability to add and manipulate plug-ins, as well as automation recording – all from the VS-700C Control Surface.

Using the Channel Strips

The Channel Strips section of the Control Surface provides eight strips with a ninth that is dedicated as a Master fader. The Master fader is assigned to the first bus in a project by default, but that can be changed by clicking and dragging the WAI (Where Am I) indicator to a new bus.

Each Strip provides a motorized (and touch sensitive) fader, a 5-segment LED meter, a SEL(ect) button, ARM button, SOLO button, MUTE button, and a rotary encoder. By default, the encoders provide access to a track’s Pan parameter, but each encoder actually provides access to four different parameters. Press the ASSIGN button (located to the left of the encoders) to change the current encoder parameter. The encoder assignments can also be customized. By default, the encoders control Pan, Send Volume, Input, and Output.

Change Send Volume to Trim

Since the send parameters can be accessed via the CHANNEL STRIP CONTROL section of the Surface (which I will talk about later in this chapter), I like to have control over the Trim track parameter rather than Send Volume. To customize the encoders, choose Tools > VS-700 to open the V-Studio 700 Property Page. Click the SURFACE tab and then in the Alternate Encoder Functions section, you’ll see all the current encoder parameter assignments. The encoders act differently depending on if the TRACK, BUS, or I/O CONTROL buttons on the Surface are pushed. In this example, click the Send1 Vol parameter under the Track button and change it to Trim. Now you have control over Trim for each track, and you can customize the other encoder assignments to your liking as well.

Tracks and Layers

To use the Channel Strips for track control, press the TRACK button on the Surface. If you have more than eight tracks in a project, you can bank the Strips to control different groups of tracks by pressing the +8 or –8 buttons under the FADER BANK label. This will assign the Strips to the next/previous eight tracks, respectively. If you hold down the SHIFT button simultaneously, you can bank by +1 or –1 tracks instead of eight.

Adjusting Track Parameters

Obviously, the fader for each Channel Strip controls track volume. Touching the fader displays the current track volume in the LCD display and moving the fader changes the volume. The 5-segment LED meter displays the track output level during playback, however, you’ll probably still rely on SONAR’s on-screen track meters since they provide a much higher resolution. Pressing the SEL(ect) button for a Strip does two things – it makes that track the active track in SONAR and it selects that track for the CHANNEL STRIP CONTROL section on the Surface (which provides EQ, Send, and ACT functions).
Select By Touch
By default, the fader touch feature and the SEL button are independent of one another. Meaning, you can keep one track as the active track and still adjust other track volumes. However, you may want the active track to be the same as the one you are adjusting automatically. You can do this by choosing Tools > VS-700. Then in the V-Studio 700 Property Page (in the Options section under the SURFACE tab), put a checkmark next to the Fader Touch Selects Channel option. Now whenever you touch a fader, that channel/track is automatically selected for the Surface and made active in SONAR.

The ARM, SOLO, and MUTE buttons for each Strip work as you would expect, however, to the left of each row of buttons, you’ll find master buttons also labeled ARM, MUTE, and SOLO (although they are called Rude ARM, Rude MUTE, and Rude SOLO in the V-Studio 700 help). Pressing each of these buttons will arm, mute, and solo every track in a project or disarm, unmute, and unsolo any already armed, muted, or soloed tracks. In addition, these buttons also light up whenever any track is armed, muted, or soloed to serve as a reminder in case you don’t currently have the track(s) on the screen or shown on the Surface. Plus, the Rude SOLO button provides two additional functions – SHIFT + Rude SOLO toggles SONAR’s Dim Solo mode and CTRL + Rude SOLO toggles SONAR’s Exclusive Solo mode.

I’ve already talked about the rotary encoders – press the ASSIGN button to choose one of four track parameters and turn the encoder to change the value. For finer value adjustment, hold down SHIFT while turning the encoder.

Flip Mode for Fader Control
You can also control encoder parameters with the Channel Strip faders using the Flip mode. Press the FLIP button (located below the I/O CONTROL button on the Surface) and the current encoder parameter is temporarily assigned to the fader while the volume is assigned to the encoder. This can be helpful if a parameter has a wide value range and you don’t want to spend time turning the encoder multiple times. Pressing the FLIP button again, swaps the parameters back.

Set to Default or Revert To Previous
There may be times when you want to set a parameter back to its default value. In addition to turning, the encoders can also be pushed down like buttons. Doing so sets an encoder’s current parameter to the default value. To set volume parameters to default, first press FLIP, then press the encoder(s), and press FLIP again. In addition, you can customize the default value for track parameters in SONAR by right-clicking a parameter with your mouse and choosing Value > Set Snap-To = Current. This will set the default value to the current parameter value.

There may also be times when you want to try a different parameter value, but still be able to go back to the previous value quickly and easily. You can do this with the Revert To function. First, change a parameter to something different to try a new value. When you want to go back to the previous value, hold the COMMAND button on the Surface and then rotate an encoder or touch a fader and then let go of the COMMAND button. This is a great way to test out different track levels, etc.
**Accessing Track Layers**
The Control Surface lets you work with track layers via a special Layer mode. To activate the mode, press SHIFT + TRACK (LAYERS). The Rude MUTE and SOLO buttons will blink, indicating that the Surface is in Layer mode. In this mode, the Channel Strips still work as before, however the SEL(ect), MUTE, and SOLO buttons work differently. Press the SEL button to make a track active. Each layer of the active track will be displayed in the LCD and each MUTE and SOLO button will correspond to a different layer in the active track (instead of individual tracks). Therefore, in Layer mode, the faders and encoders will still control their associated track parameters, but the MUTE and SOLO buttons will control layers instead of tracks. To exit Layer mode, press the TRACK button.

**Buses and Mains**
To access buses in a project, press the BUS button. The Channel Strips then control bus parameters instead of track parameters. If you have more than eight buses, you can also bank Strips as you do with tracks to control the extra buses. In addition, the Channel Strip controls work the same for buses as they do for tracks except that the ARM buttons have no function and the encoders have different parameter assignments (which can also be customized as I explained earlier in this chapter). Moreover, since buses don’t have an active status in SONAR, the SEL button just selects the bus for the Surface so you can control bus EQ and sends.

Pressing the MAIN button on the Surface gives you control over the VS-700R audio outputs (shown in the Mains section of SONAR’s Console view, see Figure 16). As with tracks and buses, you can use the FADER BANK buttons to access all the outputs. You can control output level with the faders and mute with the MUTE buttons. You can also easily set default values for the faders using the FLIP button and pressing the encoders, as well as using the Revert To function, but no other parameter adjustments are provided. However, in SONAR you can group the Mute parameters or the faders and these groupings are carried back to the Surface.

**Channel Strip Locking**
A very useful feature provided by the Control Surface is the ability to lock individual Channel Strips to tracks and buses. A locked Channel Strip is unaffected by the FADER BANK buttons, which means you can keep certain tracks/buses accessible on the Control Surface while still banking others. For example, you may want to lock Strips 5 through 8 to four buses (such as drums, vocals, guitars, and bass) while using Strips 1 through 4 to bank through the track list. This would let you continue to mix tracks while also maintaining control over your buses at the same time. To lock a Strip, press SHIFT + SEL. A locked track/bus in SONAR is shown with an orange outline around the WAI indicator and the Channel Strip has an asterisk shown on its LCD. Press SHIFT + SEL again to unlock a Strip. You can also press COMMAND + SEL to temporarily toggle all Strip lock assignments letting you quickly switch back and forth between a set of locked Strips or having all Strips free for banking.
Working with Sends
You can work with preexisting sends in a project using the CHANNEL STRIP CONTROL section of the Control Surface (which I’ll talk about shortly), but if you want to begin using sends from scratch, you need to use Channel Branch mode.

Channel Branch Mode
In Channel Branch mode, you can insert, delete, and assign sends for tracks (bus sends still need to be added via mouse, unfortunately – although, you can assign SONAR’s Insert Stereo Bus function to one of the ACCESS PANEL buttons, if you’d like). This mode also allows you to control more than the first four track sends, which is the limit for the CHANNEL STRIP CONTROL section.

Setting Up Sends in Channel Branch Mode
To enter Channel Branch mode, press ALT + SEL (for the track you want to edit). The first Channel Strip will now control the track you chose and the remaining Strips will control any existing sends (as shown in the LCD). If a Strip doesn’t have a send assigned to it, the LCD will be blank. To insert a new send for the track, press SEL for one of the unassigned Strips. Initially, the send is not assigned a bus, so you need to rotate the Strip’s encoder to assign a bus and then press the encoder. Unfortunately, you need to chose an existing bus, you can’t create a new one from the Surface. Hopefully, this feature will be added in a future update. If you need to reassign a send, press CTRL + SEL and use the encoder again. You can also delete an existing send by pressing SHIFT + MUTE (on the Strip representing the send you want to delete).

Controlling Sends in Channel Branch Mode
Once you have a send configured, you can use the various Channel Strip controls to change the send parameters. The fader changes send volume. The ARM button toggles the send pre/post parameter. The SOLO button solos the send. The MUTE button toggles the send on/off.

When you’re finished setting up and/or controlling sends in one track, you can switch tracks (while remaining in Channel Branch mode) by pressing the FADER BANK buttons. You can also exit Channel Branch mode by pressing the TRACK, BUS, or MAIN buttons under the FADER VIEW label.

Using Sends via the Channel Strip Control Section
Controlling the first four sends on a track is actually easier using the CHANNEL STRIP CONTROL section. Although, if you need to automate more than two send levels simultaneously, Channel Branch Mode is still the way to go because you can manipulate all eight faders while recording automation (explained later in this chapter). To use the CHANNEL STRIP CONTROL section, press the SEND button at the bottom of the section to access the send controls. To change the send parameters for a specific track, push the SEL button of the Channel Strip representing that track. The four columns of controls in the CHANNEL STRIP CONTROL section represent each of the first four track sends. The existing sends will be shown in the LCD. Initially, you’ll see the send levels, but you can change the display by pressing the DISPLAY button.

The first row of knobs controls send level. The second row controls send pan. The third row controls whether the send is pre or post. The fourth row (which contains buttons) toggles the sends on/off. The knobs in the first two rows can be pushed to set the level and pan parameters to their default values.
Personally, I usually like to have all my sends and buses set up previously using a project template. I always have four sends in each track whether I need them or not because it saves me the time of having to add them later. This way, I rarely need to use Channel Branch mode and can use the CHANNEL STRIP CONTROL section almost exclusively, which saves time and provides a more efficient workflow (except possibly when recording send automation).

**Adjusting Per Track EQ**

In addition to sends, the V-Studio 700 gives you access to the per-track EQ that SONAR has built-in to every audio track. Like with sends, the EQ is accessed via the CHANNEL STRIP CONTROL section of the Control Surface. Press the SEL button for the track you want to adjust and press the EQ button at the bottom of the CHANNEL STRIP CONTROL section.

The EQ controls on the Surface give you access to four bands of EQ, each with a set filter type – this setup cannot be changed. Bands 1 through 4 provide the filter types LoShelf, Peak, Peak, and HiShelf, respectively (and you will see these labels displayed on the LCD). The four columns of controls represent each of the four bands in order from left to right. Initially, you’ll see gain levels on the LCD, but you can change this by pressing the DISPLAY button.

The first row of knobs control EQ gain. The second row controls EQ frequency. The third row controls EQ Q (shape). The fourth row (which contains buttons) toggles each EQ band on/off. Any of the knobs can be pushed to set gain, frequency, and Q parameters to their default values.

This might seem a bit limiting at first, but this EQ setup actually covers most mixing circumstances. However, since the built-in SONAR track EQ is actually just a built-in instance of the included Sonitus:equalizer, you can get access to the additional filter types as well as two more EQ bands (for a total of six) by disabling the track EQ and inserting the Sonitus:equalizer as a plug-in, which can then be controlled via ACT from the Control Surface.

**Adding Plug-Ins and Using ACT**

Using the Control Surface and SONAR’s ACT functionality, you have full control over plug-ins. They can be inserted into tracks, deleted from tracks, bypassed, have their property pages opened, closed, and moved – all without taking your hands off of the Surface (except if you want to change ACT parameter assignments).

**Setting Up Plug-Ins with the Control Surface**

To begin working with plug-ins, you need to activate Plug-In mode by pressing CTRL + SEL for the track you want to edit. If the track doesn’t have any plug-ins in its FX bin, you’ll see the message “No Plug-Ins” displayed in the LCD. Existing plug-ins are displayed in columns with each column spanning two Channel Strips as shown in Table 1 (a replica of Table 31 from the V-Studio 700 help).

<table>
<thead>
<tr>
<th>LCD Top</th>
<th>Channel Strips</th>
<th>Channel Strips</th>
<th>Channel Strips</th>
<th>Channel Strips</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCD Bottom</td>
<td>Plug-in 1</td>
<td>Plug-in 3</td>
<td>Plug-in 5</td>
<td>Plug-in 7</td>
</tr>
<tr>
<td></td>
<td>Plug-in 2</td>
<td>Plug-in 4</td>
<td>Plug-in 6</td>
<td>Plug-in 8</td>
</tr>
</tbody>
</table>

This means Channel Strip 1 controls plug-in 1, Channel Strip 2 controls plug-in 2, and so on (while in Plug-In mode).
Inserting a Plug-In
Once Plug-In mode is activated, you can insert a plug-in by doing the following:

1. Push the ARM button on the Channel Strip that represents the FX bin position at which you want the plug-in inserted. In other words, if you already have three plug-ins in a track and you want to insert a new plug-in at the second location in the FX bin list, press the ARM button of Channel Strip 2. This will insert the plug-in as the second plug-in in the FX bin and move the other plug-ins down one position in the list.

2. After pressing the ARM button, the LCD will show the current plug-in menu structure you have set up in SONAR. The encoder for Strip 1 controls the root menu (meaning anything that shows up in the first menu that displays when you right-click an FX bin and choose Audio FX). If you have plug-ins in the root menu, those plug-in names are displayed immediately. If you have folders in the root menu, the name of the folder is shown and then the name of the plug-ins in that folder. The encoder for Strip 3 controls the subfolder menu.

3. Once you’ve selected the plug-in you want to insert, press the encoder currently being adjusted. For example, if you’re using the encoder for Strip 3 to choose a plug-in that’s inside a folder, press that encoder to insert the plug-in.

Custom Plug-In Menu for Quick Inserts
To optimize your workflow when using plug-ins, you can customize your plug-in menu in a couple of ways. One way would be to create a Favorites folder containing the plug-ins you use the most and positioning that folder at the top of the menu. However, an even better solution is to add your favorite plug-ins to the top of the root plug-in menu. You can do this by right-clicking the FX bin of an audio track and choosing Audio FX > Plug-In Layouts > Manage Layouts. Then use the Plug-in Menu Layout section of the Cakewalk Plug-In Manager to customize your current plug-in menu or create an entirely new menu. Personally, I have my favorite plug-ins listed at the top of the root menu. This allows me to quickly access my most used plug-ins with a quick turn of the first Channel Strip encoder on the Control Surface while in Plug-In mode.

Deleting or Bypassing a Plug-In
While still in Plug-In mode, you can delete or bypass a plug-in very easily. To delete a plug-in, press the SOLO button on the Channel Strip representing the plug-in. To bypass a plug-in, press the MUTE button on the Channel Strip representing that plug-in.

To exit Plug-In mode, press the TRACK (or BUS) button under the FADER VIEW label on the Surface.

Controlling Plug-Ins with ACT
Once inserted, plug-ins can be controlled via the Control Surface with SONAR’s ACT functionality. With ACT (and some additional features provided by the Surface itself), you can access any plug-in in any track (or bus), adjust plug-in parameters, as well as open/close/move plug-in property pages.
5. Mxi

Controlling Plug-in Property Pages
When a plug-in is inserted, its property page is automatically opened. If you don’t like its position on the screen, you can move it around by pressing and holding the COMMAND button while adjusting the Surround Joystick. It’s not quite as accurate as using a mouse, but it’s nice not to have to take your hands off the Surface.

If you need to access a different plug-in property page that’s already open, you can cycle through the pages (and any open windows) in the SONAR workspace by pressing the NEXT button in the ACCESS PANEL section. You can also close any windows that may be in your way by pressing the CLOSE button, which closes the currently active window. An alternative to closing windows is to use the T-Bar and SONAR’s X-ray feature to fade the windows or make them invisible. To do this, press the X-RAY button under the T-Bar and then move the T-Bar down/up to hide/show windows, respectively. However, this will fade all open windows and won’t help if you just want to remove some windows because of screen clutter, so you’ll probably want to keep some plug-in property pages closed.

What’s nice about having the VS-700C control surface is you don’t need to have plug-in pages open in order to access their parameters (which I’ll talk about in the next section). However, you do still need to be able to put the focus on specific plug-ins in specific tracks, plus you may sometimes want to open the property pages for a better view of the adjustments you’re making. You can focus and open plug-ins using the Control Surface, as follows:

1. Press SEL for the track with which you want to work and then push the ACT button in the CHANNEL STRIP CONTROL section.
2. You’ll notice that one of the plug-ins in the FX bin of the track has a dashed outline (see Figure 17). This indicates that it is the active plug-in, which is also indicated in the Control Surface LCD when you press the ACT button. To make a different plug-in in the FX bin active, press COMMAND along with PAGE LEFT or PAGE RIGHT in the CHANNEL STRIP CONTROL section.
3. To open the plug-in’s property page, press COMMAND + ACT.

Of course, plug-ins with their property pages already open can easily be focused by pressing the NEXT button in the ACCESS PANEL section to simply put the focus on the open page, which is the same thing as putting the focus on a closed plug-in. However, this method forces you to cycle through every open page rather than being able to first select a track and then choose a plug-in on that specific track.

Controlling Plug-in Parameters
You may have noticed from the previous discussion that pressing the ACT button in the CHANNEL STRIP CONTROL section puts the Surface into ACT mode. This mode automatically assigns the twelve knobs and four buttons in that section to the parameters in the currently active plug-in. You can see which parameters the knobs and buttons control by using the DISPLAY button to change the row of controls that is shown on the LCD. In addition, the two PAGE buttons at the bottom of the section allow you to access three additional pages of parameter assignments – a total of four pages or sixty-four adjustable parameters.
Turning any of the knobs changes their assigned parameters. Pressing the knobs returns the parameters to their default values. The buttons are usually assigned to parameters that provide on/off values. Of course, if you don’t like the parameter assignments, you can change them (as with any ACT parameters) and the new assignments will be retained across all projects.

The Control Surface also lets you use the T-bar to control a single ACT parameter by pressing the ACT button located beneath the T-bar. I like to use the T-bar when I need to make smooth parameter changes for recording automation, but other than that, I usually keep it set to X-ray mode and use it for that purpose.

**Recording Changes with Automation**

Recording automation with the VS-700C control surface is very easy, and can be done by doing the following:

1. Enable write automation. To do this for a single track, press the SEL button for that track and then press the WRITE/OFF button under the AUTOMATION label on the Surface. To enable for all tracks, press a SEL button for any track. I’ve found that if a SEL button is not lighted on any of the Channel Strips, this procedure will not work. Then press COMMAND + WRITE/OFF. You can also use the same procedures for buses by pressing the BUS button under the FADER VIEW label. You can even have both tracks and buses enabled for automation at the same time and switch between them while writing.

2. Position the Now Time to the point where you want to start writing automation. Then press PLAY.

3. Adjust the enabled controls on the Surface. One thing to note about the faders is that since they are touch-sensitive, they will begin writing automation as soon as you touch them – other controls need to be moved first.

4. When you’re finished writing, press STOP.

5. To make sure read automation is enabled: for a single track, press the SEL button for that track and then press SHIFT + WRITE/OFF; for all tracks, press a SEL button for any track and then press SHIFT + COMMAND + WRITE/OFF.

Other automation-related functions available from the Surface are toggling SONAR’s Offset mode by pressing the OFFSET button, as well as taking an automation snapshot by pressing SHIFT + OFFSET.

**Automated Track Mute**

I’m also happy to report that the VS-700C provides support for automated mute, however, this is only for tracks – it doesn’t currently work for buses. To access automated mute for a track, first right-click on the track’s Mute button in SONAR and choose Switch To Automated Mute from the menu. During automation recording (as per the instructions in the previous section), you can then press ALT + MUTE on the Channel Strip representing the track to toggle Mute on/off and these button presses will be recorded as automation.
6. Final Thoughts and Tips for the V-Studio 700

To be honest, I wasn’t really planning to upgrade my studio when the V-Studio 700 hit the market. I already had a decent setup and the equipment got the job done. However, to me (as a professional) time is money, and the one thing above all that the V-Studio 700 brings to the table is a very high level of integration. This equals a more streamlined workflow, which in turn equals less time it takes to do many different tasks. Moreso, the V-Studio 700 goes above and beyond this by providing very high-quality features. The VS-700R audio interface is one of the best available with very clean preamps and plenty of professional connections. The VS-700C control surface is very solidly built and integrates with SONAR like nothing else on the market. And while I didn’t absolutely need the Fantom VS synth, I found it to be a very welcome addition to the package. The sounds are excellent and the fact that it’s a hardware synth (which can be run like a plug-in) makes it all that more powerful. I now use it on a regular basis in many of my projects.

Of course, the System isn’t perfect. As I’ve mentioned throughout this book, there are some things that I would like to see added or improved. Luckily, Cakewalk is providing excellent support and has issued a number of updates (with more on the way). In addition, I know that some users have expressed concern about the cost, but you have to remember that this is a high-end, professional system – it’s meant for people doing professional music work or those who want to enjoy Cakewalk’s flagship product in their personal project studios. Plus, Cakewalk does offer the system components as separate purchases, if that’s the way you want to go.

For me, the V-Studio 700 is exactly what I’ve been looking for throughout my time as a Cakewalk SONAR user. My entire workflow in the studio has been significantly improved and I can safely say that the V-Studio 700 provides the ultimate studio experience for SONAR users.

I hope you’ve enjoyed reading this eBook and to close things out, I want to share a few final tips that I thought you might find useful.

Fantom VS Instrument Definitions
Cakewalk has put together some instrument definitions for the Fantom VS that can be used in SONAR to make patch selection easier. Basically, this allows you to choose banks and patches by name when selecting via a MIDI track’s Bank and Patch parameters. The drawback is that you must use the Fantom VS as a hardware synth (instead of as a VST plug-in) in order to utilize the instrument definitions. Go to http://www.cakewalk.com/support/kb/reader.aspx?ID=2007012927 for a more detailed explanation and for information on where to download and how to set up the instrument definitions.

VS-700C Control Surface Cover
Those of you who already own the V-Studio 700 system or the VS-700C individually, know that the unit can get a bit dusty sitting there in the studio over a long period of time. If you’d like to keep the unit dust-free, you might want to consider getting a cover for it. While there isn’t a dedicated cover available, the Gator GMC-3333 Mixer and Equipment Cover fills the void nicely. It is a stretch-to-fit cover that is hand washable and provides an adjustable shock cord for a snug fit. Go to http://digifreq.com/?GatorCover for more information.
Using the VS-700C with Other Software Applications

In addition to the tight integration it provides with SONAR, the VS-700C control surface includes a Mackie Control emulation feature. This means that any software application that supports the Mackie Control hardware surface can also take advantage of the VS-700C. Of course, the level of integration will not be the same as it is with SONAR, but it is still quite significant and extends the use of the VS-700C tremendously.

While I can't provide information on how the VS-700C works with every software application, I thought I would at least provide one example that has proven useful to me. Besides music and audio, I also work in the realm of video and my favorite software application for video work is Sony Vegas (http://digifreq.com/?SonyVegas). Thankfully, Vegas provides Mackie Control support. So in addition to working in SONAR, I can use the VS-700C in Vegas as well. To set up Vegas to work with the VS-700C, do the following:

1. In Vegas, choose Options > External Control to activate the External Control function.
2. Choose Options > Preferences and click the MIDI tab in the Preferences dialog box.
3. In both the MIDI output and MIDI input lists, put a checkmark next to CONSOLE (VS-700).
4. While still in the Preferences dialog box, click the External Control & Automation tab.
5. From the Available Devices list, choose Mackie Control and click the Add button.
6. In the Active Control Devices list, double-click the Mackie Control device.
7. In the Configure Mackie Control dialog box, for Device Type, choose Add Emulated Mackie Control Device.
8. Channel Mapping should automatically be set to Chan 1 – 8.
9. For both the MIDI input and MIDI output parameters choose CONSOLE (VS-700) if they are not assigned automatically.
10. The remainder of the dialog box allows you to reconfigure the various Mackie buttons to your liking if you're not happy with the default settings.
11. Click OK.

To learn more about how to reconfigure the Mackie settings or use the Mackie Control mode, read the Using Hardware Controllers section of the Vegas help.

**Generic Control Device**

When using the Mackie Control mode in Vegas, you can only reconfigure the buttons listed in the dialog box. You’re not allowed to reconfigure many of the other controls. If you want to do your own configuration from scratch, choose the Generic Control device instead. You will then need to configure every control on the VS-700C individually to each of the Vegas functions you want to use from the Surface, but this method gives you complete control on how the Surface can be used with Vegas. I’m sure many other software applications provide both Mackie and Generic control as well. You’ll need to read the associated documentation for more information.
Using the VS-700R with Other Software Applications
As a professional audio interface that provides industry standard drivers, the VS-700R can also be used with other software applications. Of course, outside of SONAR, you don't have access to the VS-700 Property Page. To remedy this situation, Cakewalk has provided a stand-alone software application (the VS-700R I/O Editor) to control, change, and even save the settings for the VS-700R.

To install the VS-700R I/O Editor, insert your V-Studio 700 DVD (the same one that contains the V-Studio 700 drivers, etc.) and navigate to the Tools folder. Inside that folder, double-click the file called SETUP.EXE. Follow the instructions during installation and then launch the Editor by choosing Start > All Programs > VS-700R IO Editor > VS-700R IO Editor.

You will then be presented with a graphical representation of the eight microphone preamp inputs as well as the Direct Monitor Mixer. Onscreen controls for all of the various parameters associated with these features are shown and can be manipulated with a mouse. When you have the parameters set to your liking, you can save them (and load them later) using the File menu. Additional information about how to use the Editor can be found in the manual by choosing Help > VS-700R I/O Editor Manual.
Appendix A, V-Studio 700 Resources

While I've covered a lot of ground in this eBook, there is still plenty of additional information to be found with regards to the V-Studio 700. Below you will find some supplementary resources that should be helpful in your further exploration of the V-Studio 700 system.

ProAudioTutor
http://garrigus.com/?ProAudioTutor
This is the official site of the Cakewalk V-Studio 700: A Closer Look eBook. Here you will find a dedicated section of the site for the eBook with information, downloads, and any future updates that may become available.

Scott’s V-Studio 700 Information Page
http://garrigus.com/?VStudio700
Visit this page for additional information about my experiences with the V-Studio 700 as well as links to videos. Plus, you'll find discussions here and you can also post your own questions about the system, which I will be happy to try and answer.

Cakewalk's V-Studio 700 Site
Find additional information about the V-Studio 700 here including an overview of the system, a list of features, detailed specifications, access to support, artist impression videos, and news.

Cakewalk's V-Studio 700 Forum
Here you can find discussions focused on the features and uses of the V-Studio 700 system. You can also post your own questions and connect with other V-Studio 700 users.

Cakewalk’s V-Studio 700 Videos on YouTube
http://www.youtube.com/user/CakewalkSoftware#grid/user/A5059721CCA85720
Cakewalk has provided a nice collection of videos on YouTube covering the V-Studio 700 including performing various tasks with the system and artist impressions.

DigiFreq: The Music Technology and Pro Audio Resource
http://www.digifreq.com/digifreq/
I will be providing future additional coverage of the V-Studio 700 system in upcoming issues of the DigiFreq newsletter. Visit the site to sign up for free.

SONAR Power! Books
http://garrigus.com/?PowerBooks
Visit the Power! books site to learn more about my SONAR Power! books, which will help you get the most out of your Cakewalk SONAR software.

Mixing Audio by Roey Izhaki
http://digifreq.com/?IzhakiMixing
While this book has nothing to do with the V-Studio 700 (and no, I am not the author), it is one of the best books currently on the market covering the topic of mixing. The techniques provided here can help you hone your mixing craft and get even more use out of the V-Studio 700 while mixing your projects.
Appendix B, Additional Information

Referenced in the eBook are a small number of additional pieces of information that you may find useful. I've included that information for you here.

**Fantom VS Output Affects FX Routing**
Some of the Fantom patches use effects to get their distinct sound and changing the Output parameter changes how a Part is routed through the Fantom’s effects, which can change the sound of the patch. Unfortunately, the only way I've found to get the Chorus and Reverb parameters to work is to set the Output of each Part to L+R. I still need to do more research on the inner workings of the Fantom so if I find a better solution to this problem I'll post it over at DigiFreq: [http://digifreq.com?VStudio700](http://digifreq.com?VStudio700)

**Fantom VS Chorus and Reverb FX Bug?**
For some reason, on my system, whenever I open my Fantom project template, the Chorus and Reverb parameters for each track do not work. To get them working, I have to open the Mixer in the Fantom VS Editor and turn the Chorus and Reverb effects off and on. This seems to “reset” the effects and I can then adjust the amounts via the Track parameters again. To remind myself to do this each time, I have the Fantom Editor open automatically whenever the template is opened. I don’t know if this is a bug, but again, if I find a solution to this problem in the future, I'll post it over at DigiFreq: [http://digifreq.com?VStudio700](http://digifreq.com?VStudio700)

**Time Selections are Automatically Split**
Be aware that if you make a time selection that covers only part of a clip (or parts of multiple clips) and then you use the Edit mode move functions, the clip (or clips) will be automatically split at the selection boundaries and the data will leave blank space where it was previously located. So, for example, let’s say you have one large clip and you select only part of that clip. If you move the selected section, that section will then become an independent clip and you will have two new clips (with space in-between them) remaining from the original one clip. Of course, you can always undo the procedure if you move the selection by mistake.